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About Maptek Documents
The following conventions are typically used in training manuals and guides:

Example Description

Design >Object Edit Text in bold are commands or options selected from a menu, panel,
or button.

Top Down or Bottom-
Up design method

Text in bold is also used for emphasis, specific terms, tab names,
column names, panel group names etc.

<LEVEL>_SURVEY_
POINTS>

File names or extensions, variables, formulas, text entry, layers,
triangulations, databases, scripts, macros,
and data such as displayed in the Report window, are in code font.

Tip: Designates a hint such as an effective use of an option.

Note: Designates a point to draw attention to; an informational comment.

Important: Designates an alert to draw particular attention to.
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1. Introduction
This document describes the BlastLogic Server Open Data Protocol (hereinafter OData) service,

a web service provided to facilitate access to BlastLogic data by third party clients.

Use the OData service to develop and integrate custom reports and dashboards in the following

applications:

Applications for developing custom reports and dashboards

Microsoft Excel 2010 / 2013 (Power Query)

Microsoft Excel 2016 (for acquiring and transforming data)

Microsoft Power BI

TIBCO Spotfire

Websites

Reporting applications that can consume OData (version 4.0)

Applications for integrating custom reports and dashboards

Microsoft SQL Server Integration Services (SSIS)

Software AG webMethods

Any client or agent capable of consuming JavaScript Object Notation (JSON) over

Hypertext Transfer Protocol (HTTP)
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2. OData Feeds
The following OData live and synchronisation feeds are available in BlastLogic:

Feed name Live feed Synchronisation feed

BackfillingEntries ✔ ✔

BackfillSheets ✔ ✔

BlastProducts ✔ ✔

Blasts ✔ ✔

BlastsStable ✔ ✔

BlastStatistics ✔ ✖

ChargeSheetDeckTotals ✔ ✖

ChargeSheetPrimerTotals ✔ ✖

ChargeSheets ✔ ✔

ChargingEntries ✔ ✔

ChargingEntryDecks ✔ ✔

ChargingEntryPrimers ✔ ✔

DensityMeasurements ✔ ✔

DippingEntries ✔ ✔

DipSheets ✔ ✔

DrillingEntries ✔ ✔

DrillingEntriesStable ✔ ✔

DrillingEvents ✔ ✔

DrillingEventsStable ✔ ✔

DrillingShiftTotals ✔ ✔

HoleAnomalies ✔ ✖

HoleSnapshots ✔ ✔



3

Feed name Live feed Synchronisation feed

HoleSnapshotDecks ✔ ✔

HoleSnapshotPrimers ✔ ✔

Holes ✔ ✔

HolesStable ✔ ✔

InventoryChanges ✔ ✔

LoadedDecks ✔ ✔

LoadedPrimers ✔ ✔

ReconciledDecks ✔ ✔

ReconciledPrimers ✔ ✔

SiteParameters ✔ ✔

SurveyingEntries ✔ ✔

SurveySheets ✔ ✔

TargetChargePlanDecks ✔ ✔

TargetChargePlanPrimers ✔ ✔

Depending on the type of data you need, you can access OData feeds from either of the following

sites:

Live feed: [server uri]/odata/[site code]

Synchronised feed: [server uri]/sync/[site code]

Note: Maptek welcomes any requests for additional data to be made available in the OData

feeds.
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2.1 Structural differences between live and
synchronisation feeds
The structural differences between the live OData feeds and their corresponding synchronisation

feeds are as follows:

Unlike the live OData feeds, all synchronisation feeds have an additional RefreshedTime

column that indicates the last time the record was updated.

Tip: Filter on this column to retrieve only the rows that have recently changed.

Note
Before BlastLogic 2023, the synchronisation feed (the sync feed) was originally
implemented to report precalculated data. This had the advantage of reporting a lot more
data without straining server resources. However, this data was not truly live as data could
take up to 24 hours to recalculate.
In BlastLogic 2023 and beyond, the precalculated data is refreshed near instantly. The live
and sync feeds both use this precalculated data and also report the same data with some
minor differences in which columns are presented.

The following synchronisation feeds have a column named Deleted to indicate that the row

was in the live feed but has since been removed:

BackfillingEntries

ChargingEntries

ChargingEntryDecks

ChargingEntryPrimers

DensityMeasurements

DippingEntries

LoadedDecks

LoadedPrimers

ReconciledDecks

ReconciledPrimers

SurveyingEntries

TargetChargePlanDecks

TargetChargePlanPrimers

The LastModified field exists in the following live feeds but not in their corresponding

synchronisation feeds:
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ChargingEntryDecks

ChargingEntryPrimers

LoadedDecks

LoadedPrimers

ReconciledDecks

ReconciledPrimers

TargetChargePlanDecks

TargetChargePlanPrimers
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2.2 Entity relationship diagram (ERD)
The following diagrams show the entity relationship for non-charging and charging entities.

Figure 2-1 Entity relationship diagram (non-charging entities).
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Figure 2-2 Entity relationship diagram (charging entities)
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2.3 Backfilling entries

Note: The BackfillingEntries feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The BackfillingEntries live and synchronisation feeds contain an item for each backfill sheet entry in

the site.

Note: Cancelled backfilling entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the backfill sheet.

SheetName Text Y The name of the backfill sheet.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The name of the blast that the hole belongs to.

CreatedTime Date
Time

N The date and time the entry was created.

LastKnownDepth Number m N The last known actual depth when the entry was
created.

LastKnownDepthTime Date
Time

N The date and time the last known depth was
measured.

TargetDepth Number m N The target depth to backfill to initialised when the
entry was created, and updated at the time the
hole was backfilled.

StartedTime Date
Time

N The date and time the crew started backfilling
the hole.

CompletedTime Date
Time

Y The date and time the crew finished backfilling
the hole.

CrewName Text N The name of the crew that backfilled the hole.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

DipDepth Number m N The dip depth measured by the crew before
backfilling.

Water Number m N The water length measured by the crew before
backfilling.

WetSides Number m N The wet sides length measured by the crew
before backfilling.

Temperature Number K N The temperature measured by the crew before
backfilling.

WasBackfilled Boolean N Indicates whether the hole was backfilled.
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Property name Type Unit Filterable Description

Note: IfWasBackfilled is true and
CrewDipDepthAfter is null, the hole is deemed
to be backfilled to the target depth.

Comment Text N The comment entered by the crew.

CrewCheckRequired Boolean N True if the crew needs to dip this hole after
backfilling.

CrewDipDepthAfter Number m N The dip depth as measured by the crew after
backfilling.

SupervisorCheckRequired Boolean N True if the supervisor needs to dip this hole after
backfilling.

SupervisorDipDepthAfter Number m N The dip depth as measured by the supervisor
after backfilling.

SupervisorName Text N The name of the supervisor that dipped the hole
after backfilling.

RefreshedTime Date
Time

Y The last time the update or refresh job altered
this row.

Note: This property is not applicable to the
BackfillingEntries live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
BackfillingEntries live feed.
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2.4 Backfill sheets

Note: The BackfillSheets feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The BackfillSheets live and synchronisation feeds contain summary data for all backfill sheets in the

site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text Y The name of the charge sheet.

BlastNames Text Y The comma-separated list of blasts covered by the
sheet.

Instructions Text Y The instructions for the crew.

CreatedTime Date
Time

Y The date and time the sheet was created.

CreatedBy Text Y The person who created the sheet.

ShowWater Boolean Y Indicates whether to show theWater column on the
printed sheet.

ShowWetSides Boolean Y Indicates whether to show theWet sides column
on the printed sheet.

ShowTemperature Boolean Y Indicates whether to show the Temperature
column on the printed sheet.

ShowLastKnownLength Boolean Y Indicates whether to show the Last known length
column on the printed sheet.

HoleCount Integer Y The number of holes or entries, including
abandoned holes.

HoleBackfilledCount Integer Y The number of completed holes or entries.

Note: An entry is considered completed when
the hole is flagged as backfilled or a target depth is
present, the dip depth before is entered, and the
value is within the backfill tolerance.

EntryCancelledCount Integer Y The number of abandoned holes or cancelled
entries.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this
row.

Note: This property is not applicable to the
BackfillSheets live feed.
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2.5 Blast products

Note: The BlastProducts feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The BlastProductslive and synchronisation feeds contain an item for each blast product defined in

the site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Type Text Y The type of product (for example, bulk explosive, surface
delay, or electronic detonator).

Name Text Y The name of the product.

Code Text Y The product code (short name).

Description Text Y The description of the product.

Active Boolean Y Indicates whether the product is flagged active in the
catalogue.

FamilyName Text Y The name of the family the product belongs to (if any).

FamilyDescription Text Y The description of the family the product belongs to (if
any).

Colour Text Y The colour in which to display the product in #RRGGBB
format.

Cost Decimal Y The cost per unit of the product.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
BlastProducts live feed.

2.6 Blasts and blasts stable

Note: The Blasts and BlastsStable feeds require the View blasts permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The Blasts and BlastsStable live and synchronisation feeds contain data for all blasts in the site.

The BlastsStable live and synchronisation feeds provide the same properties as the Blasts live and

synchronisation feeds but without the custom blast properties, which makes the schema stable in

the face of changes to the BlastLogic blast custom properties, and guarantees the schema is

consistent across all sites. This can be useful for OData clients, such as Microsoft Excel

PowerQuery, that do not handle schema changes smoothly.
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Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text Y The alternate key.

Status Text Y A blast can have one of the
following status types:

Active
Fired
Abandoned
Suspended

FiredTime Date
Time

Y The date and time when the blast
was fired.

AbandonedTime Date
Time

Y The date and time when the blast
was abandoned.

AbandonedComment Text Y The comment explaining why the
blast was abandoned.

SuspendedTime Date
Time

Y The date and time when the blast
was suspended.

SuspendedComment Text Y The comment explaining why the
blast was suspended.

Volume Number m3 Y The volume of material expected to
be fragmented by the blast.

HoleCount Integer Y The number of holes in the blast
(including abandoned holes).

ShotfirerName Text Y The name of the shotfirer.

<Custom Properties> Degrees
for angle
type floats,
SI units for
other
types.

Y As defined in site settings. See
Custom Properties for details.

Note: Custom properties are
not applicable to the BlastsStable
live and synchronisation feeds.

RefreshedTime Date
Time

Y The last time the update or refresh
job altered this row.

Note: This property is not
applicable to the Blasts and
BlastsStable live feeds.
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2.7 Blast statistics

Note: The BlastStatistics live feed requires the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The BlastStatistics live feed contains delayed statistical data for all blasts. Properties marked as

delayed may lag behind the underlying data by approximately 5 minutes.

Note: All values consider abandoned holes unless specified otherwise.

Property name Type Unit Filterable
Real time

/
Delayed

Description

Id Integer Y Real time The primary key.

Name Text Y Real time The name of the blast.

FiredTime Date
Time

Y Delayed The date and time when the blast was fired.

HoleCount Number Y Delayed The number of holes in the blast (including
abandoned holes).

Volume Number m3 Y Delayed The volume of material expected to be
fragmented by the blast.

ExplosiveMass
Designed

Number kg Y Delayed The total designed or planned explosive
mass.

Note: Abandoned holes are excluded.

ExplosiveMass
Loaded

Number kg Y Delayed The total loaded explosive mass (typically
entered using the BlastLogic Tablet).

ExplosiveMass
Reconciled

Number kg Y Delayed The total reconciled explosive mass.

Note: Abandoned holes are excluded.

PowderFactor
Designed

Number kg/m3 Y Delayed The designed or planned explosive mass or
blast volume.

Note: Abandoned holes are excluded.

PowderFactor
Reconciled

Number kg/m3 Y Delayed The reconciled explosive mass or blast
volume.

Note: Abandoned holes are excluded.

DrillLength
Design

Number m Y Delayed The total target drill depth for all holes.

DrillLength
Actual

Number m Y Delayed The total actual drilled depth for all holes.

HolesDrilled Integer Y Delayed The number of holes that have been drilled,
including any hole that has been drilled,
dipped, backfilled, charged, surveyed, or
fired.
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Property name Type Unit Filterable
Real time

/
Delayed

Description

HolesDrilled
OutsideDepth
Tolerance

Integer Y Delayed The number of holes drilled, where the actual
drill depth less the target drill depth exceeds
the drill depth error tolerance.

Note: The target drill depth considers
survey entry. The actual drill depth considers
as-drilled, supervisor, and operator dip
depth.

HolesDrilled
OutsideCollar
Tolerance

Integer Y Delayed The number of holes drilled where the collar
error exceeds the collar error tolerance.

Note: The drill collar error considers
survey data.

HolesRedrilled Integer Y Delayed The number of holes that have been re-
drilled.

HolesAdHoc Integer Y Delayed The number of ad hoc holes.

HolesDipped Integer Y Delayed The number of holes that have been dipped
using a dipping sheet entry.

HolesDipped
OutsidCharge
DepthTolerance

Integer Y Delayed The number of holes where the last known
depth (excluding drilled depth and design
depth) less the target charge depth lies
outside the charge depth error tolerance. Dip
measurements may be sourced from drilling
entries (operator or supervisor), dip sheets,
backfill sheets, or charge sheets.

HolesCharged Integer Y Delayed The number of holes that are flagged as
charged by the engineer.

HolesCharged
OutsideMass
Tolerance

Integer Y Delayed The number of holes where the absolute
difference between the reconciled charge
mass and the design charge mass exceeds
the charge sheet mass tolerance multiplied
by the design charge mass.

Note: Holes must have a charged,
reconciled charging entry to be considered
for this calculation.

HolesStemmed Integer Y Delayed The number of holes where the topmost,
planned stemming deck overlaps a
reconciled stemming deck.

Note: Holes must have a charged,
reconciled charging entry to be considered
for this calculation.

The reconciled deck is identified as the
stemming deck closest to the plan deck as
determined by depth mid-point. A stemming
deck is defined as a deck of product type
stemming or drill cuttings.

HolesStemmed Integer Y Delayed The number of holes where the absolute
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Property name Type Unit Filterable
Real time

/
Delayed

Description

OutsideLength
Tolerance

length difference between the topmost,
planned stemming deck and the closest
reconciled stemming deck exceeds the
charge sheet stemming length tolerance.

Note: Holes must have a charged,
reconciled charging entry to be considered
for this calculation.

The closest reconciled deck is identified as
the deck closest to the planned deck by
depth mid-point.

A stemming deck is defined as a deck of
product type stemming or drill cuttings.

HolesAbandoned Integer Y Delayed The number of holes that have been
abandoned.

HolesPotential
Misfire

Integer Y Delayed The number of holes that are flagged as a
potential misfire.

PublishedDesign
TieUps

Integer Y Delayed The number of design tie-ups published.

PublishedActual
TieUps

Integer Y Delayed The number of actual tie-ups published.

RefreshTime Date
Time

Y - The date and time when the values of the
delayed properties were last refreshed.
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2.8 Charge sheet deck totals

Note: The ChargeSheetDeckTotals live feed requires the View blasts permission. To

manage site permissions, see 6.2.3 Authorisation on page 75.

The ChargeSheetDeckTotals live feed contains an item for each product planned for a charge sheet

in the specified blast.

Note: The values for the cancelled entries are excluded from the live feed.

A maximum of 1000 entries can be retrieved per request. Requests should filter by SheetId or

SheetName.

Property name Type Unit Filterable Description

SheetId Integer Y The primary key of the sheet.

SheetName Text Y The name of the charge sheet.

ProductId Integer N The primary key of the blast product.

ProductName Text N The name of the blast product.

HoleCount Integer N The number of holes containing the product.

Length Number m N The total length of deck product.

Mass Number kg N The total mass of deck product

Volume Number m3 N The total volume of deck product.

Quantity Integer N The total number of air bag or packaged products.

2.9 Charge sheet primer totals

Note: The ChargeSheetPrimerTotals live feed requires the View blasts permission. To

manage site permissions, see 6.2.3 Authorisation on page 75.

The ChargeSheetPrimerTotals live feed contains an item for each primer product planned for a

charge sheet in the specified blast.

Note: The values for the cancelled entries are excluded from the live feed.

A maximum of 1000 entries can be retrieved per request. Requests should filter by SheetId or

SheetName.
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Property name Type Unit Filterable Description

SheetId Integer Y The primary key of the sheet.

SheetName Text Y The name of the charge sheet.

ProductId Integer N The primary key of the blast product.

ProductName Text N The name of the blast product.

HoleCount Integer N The number of holes containing the product.

Quantity Integer N The total number of primer products.

2.10 Charge sheets

Note: The ChargeSheets feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The ChargeSheets live and synchronisation feeds contain summary data for all charge sheets in the

site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text Y The name of the charge sheet.

BlastNames Text Y The comma-separated list of blasts
covered by the sheet.

Instructions Text Y The instructions for the crew.

CreatedTime Date
Time

Y The date and time when the sheet
was created.

CreatedBy Text Y The person who created the sheet.

ChargeMass
Tolerance

Number % Y The allowed tolerance between the
planned and actual charge mass.

ChargeLength
Tolerance

Number m Y For the decks to not be classified as
loaded contrary to plan, the charge
length tolerance defines the
maximum allowed difference in
metres between the following: 

The actual charge length and
planned charge length.
The actual top and planned
top.

Note: A null value indicates that
charge length tolerance checking
should not be performed.

StemmingLength Number m Y For the decks to not be classified as
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Property name Type Unit Filterable Description

Tolerance loaded contrary to plan, the
stemming length tolerance defines
the maximum allowed difference in
metres between the following:

The actual charge length and
planned charge length.
The actual top and planned
top.

This tolerance overrides the
ChargeLengthTolerance for the
topmost stemming deck and the
explosive deck immediately below it
(if one exists).

Note: A null value indicates that
stemming-related decks should use
the ChargeLengthTolerance value.

ShowWater Boolean Y Indicates whether to show theWater
column on the printed sheet.

ShowWetSides Boolean Y Indicates whether to show theWet
sides column on the printed sheet.

ShowTemperature Boolean Y Indicates whether to show the
Temperature column on the printed
sheet.

HoleCount Integer Y The number of holes or entries in the
sheet, including abandoned holes.

HoleChargedCount Integer Y The number of holes or entries
flagged as charged or reconciled by
an engineer.

EntryCancelledCount Integer Y The number of abandoned holes or
cancelled entries.

RefreshedTime Date
Time

Y The last time the update or refresh
job altered this row.

Note: This property is not
applicable to the ChargeSheets live
feed.
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2.11 Charging entries

Note: The ChargingEntries feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The ChargingEntries live and synchronisation feeds contain an item for each charge sheet entry in

the site. Decks are listed in load order as groups of columns, which is useful for building a charge

sheet in landscape format. At most, 10 decks are included.

Note: Cancelled charging entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the charge
sheet.

SheetName Text Y The name of the charge sheet.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a
member of.

Row Text N The row where the hole is
positioned.

Echelon Integer N The echelon where the hole is
positioned.

Depth Number m N The charging entry dip depth if
available, else the last known
length (effective geometry).

Angle Number Degrees N The last known angle of the hole.

Water Number m N The charging entryWater value if
available, else the last known
water value.

WetSides Number m N The charging entryWetSides
value if available, else the last
known wet sides value.

Temperature Number K N The charging entry Temperature
value if available, else the last
known temperature value.

ChargeRuleName Text N The name of the charge rule used
to generate the plan.

PlanDepth Number m N The last known depth when the
plan was created.

DeckCount Number N The total number of plan decks.
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Property name Type Unit Filterable Description

PlanDeck1ProductId Integer N The primary key of the product to
load in deck #1.

PlanDeck1ProductName Text N The name of the product to load
in deck #1.

PlanDeck1Mass Number kg N The mass of the product to load in
deck #1.

PlanDeck1Quantity Integer N The quantity of the packaged
product to load in deck #1.

PlanDeck1Length Number m N The length of deck #1.

PlanDeck1Top Number m N The depth where the top of deck
#1 should come to.

PlanDeck2ProductId Integer N The primary key of the product to
load in deck #2.

PlanDeck2ProductName Text N The name of the product to load
in deck #2.

PlanDeck2Mass Number kg N The mass of the product to load in
deck #2.

PlanDeck2Quantity Integer N The quantity of the packaged
product to load in deck #2.

PlanDeck2Length Number m N The length of deck #2.

PlanDeck2Top Number m N The depth where the top of deck
#2 should come to.

PlanDeck3ProductId Integer N The primary key of the product to
load in deck #3.

PlanDeck3ProductName Text N The name of the product to load
in deck #3.

PlanDeck3Mass Number kg N The mass of the product to load in
deck #3.

PlanDeck3Quantity Integer N The quantity of the packaged
product to load in deck #3.

PlanDeck3Length Number m N The length of deck #3.

PlanDeck3Top Number m N The depth where the top of deck
#3 should come to.

PlanDeck4ProductId Integer N The primary key of the product to
load in deck #4.

PlanDeck4ProductName Text N The name of the product to load
in deck #4.

PlanDeck4Mass Number kg N The mass of the product to load in
deck #4.
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Property name Type Unit Filterable Description

PlanDeck4Quantity Integer N The quantity of the packaged
product to load in deck #4.

PlanDeck4Length Number m N The length of deck #4.

PlanDeck4Top Number m N The depth where the top of deck
#4 should come to.

PlanDeck5ProductId Integer N The primary key of the product to
load in deck #5.

PlanDeck5ProductName Text N The name of the product to load
in deck #5.

PlanDeck5Mass Number kg N The mass of the product to load in
deck #5.

PlanDeck5Quantity Integer N The quantity of the packaged
product to load in deck #5.

PlanDeck5Length Number m N The length of deck #5.

PlanDeck5Top Number m N The depth where the top of deck
#5 should come to.

PlanDeck6ProductId Integer N The primary key of the product to
load in deck #6.

PlanDeck6ProductName Text N The name of the product to load
in deck #6.

PlanDeck6Mass Number kg N The mass of the product to load in
deck #6.

PlanDeck6Quantity Integer N The quantity of the packaged
product to load in deck #6.

PlanDeck6Length Number m N The length of deck #6.

PlanDeck6Top Number m N The depth where the top of deck
#6 should come to.

PlanDeck7ProductId Integer N The primary key of the product to
load in deck #7.

PlanDeck7ProductName Text N The name of the product to load
in deck #7.

PlanDeck7Mass Number kg N The mass of the product to load in
deck #7.

PlanDeck7Quantity Integer N The quantity of the packaged
product to load in deck #7.

PlanDeck7Length Number m N The length of deck #7.

PlanDeck7Top Number m N The depth where the top of deck
#7 should come to.

PlanDeck8ProductId Integer N The primary key of the product to
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Property name Type Unit Filterable Description

load in deck #8.

PlanDeck8ProductName Text N The name of the product to load
in deck #8.

PlanDeck8Mass Number kg N The mass of the product to load in
deck #8.

PlanDeck8Quantity Integer N The quantity of the packaged
product to load in deck #8.

PlanDeck8Length Number m N The length of deck #8.

PlanDeck8Top Number m N The depth where the top of deck
#8 should come to.

PlanDeck9ProductId Integer N The primary key of the product to
load in deck #9.

PlanDeck9ProductName Text N The name of the product to load
in deck #9.

PlanDeck9Mass Number kg N The mass of the product to load in
deck #9.

PlanDeck9Quantity Integer N The quantity of the packaged
product to load in deck #9.

PlanDeck9Length Number m N The length of deck #9.

PlanDeck9Top Number m N The depth where the top of deck
#9 should come to.

PlanDeck10ProductId Integer N The primary key of the product to
load in deck #10.

PlanDeck10ProductName Text N The name of the product to load
in deck #10.

PlanDeck10Mass Number kg N The mass of the product to load in
deck #10.

PlanDeck10Quantity Integer N The quantity of the packaged
product to load in deck #10.

PlanDeck10Length Number m N The length of deck #10.

PlanDeck10Top Number m N The depth where the top of deck
#10 should come to.

RefreshedTime Date
Time

Y The last time the update or
refresh job altered this row.

Note: This property is not
applicable to the ChargingEntries
live feed.

Deleted Boolean Y True if the entry was created and
has since been cancelled.

Note: This property is not
applicable to the ChargingEntries
live feed.
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2.12 Charging entry decks

Note: The ChargingEntryDecks feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The ChargingEntryDecks live and synchronisation feeds contain an item for each planned charge

deck in the site.

Note: Decks for cancelled charging entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the charge sheet.

SheetName Text Y The name of the charge sheet.

ChargingEntryId Integer Y The primary key of the charging entry.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

Depth Number m N The charging entry dip depth if available, else the last
known length (effective geometry).

Angle Number Degrees N The last known angle of the hole.

Water Number m N The charging entryWater value if available, else the
last known water value.

WetSides Number m N The charging entryWetSides value if available, else
the last known wet sides value.

Temperature Number K N The charging entry Temperature value if available,
else the last known temperature value.

ChargeRuleName Text N The name of the charge rule used to generate the
plan.

ProductId Integer N The primary key of the product to load.

ProductName Text N The name of the product to load.

PlanMass Number kg N The mass of the product to load.

PlanLength Number m N The length of the deck.

PlanTop Number m N The depth where the top of the deck should come to.

Cost Decimal N The cost per unit of the product used in this deck.

PlanQuantity Integer N The quantity of the packaged product to load.
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Property name Type Unit Filterable Description

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
ChargingEntryDecks synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
ChargingEntryDecks live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
ChargingEntryDecks live feed.

2.13 Charging entry primers

Note: The ChargingEntryPrimers feeds require the View blasts permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The ChargingEntryPrimers live and synchronisation feeds contain an item for each planned primer

in the site.

Note: Primers for cancelled charging entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the charge sheet.

SheetName Text Y The name of the charge sheet.

ChargingEntryId Integer Y The primary key of the charging entry.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

Depth Number m N The charging entry dip depth if available, else the last
known length (effective geometry).

Angle Number Degrees N The last known angle of the hole.

Water Number m N The charging entryWater value if available, else the
last known water value.

WetSides Number m N The charging entryWetSides value if available, else
the last known wet sides value.

Temperature Number K N The charging entry Temperature value if available,
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Property name Type Unit Filterable Description

else the last known temperature value.

ChargeRuleName Text N The name of the charge rule used to generate the
plan.

ProductIds Integer N The comma-separated list of the primary keys of the
products comprising the primer.

ProductNames Text N The comma-separated list of the names of the
products comprising the primer.

PlanDepth Number m N The depth at which to load the primer.

Cost Decimal N The cumulative cost of all products comprising the
primer.

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
ChargingEntryPrimers synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
ChargingEntryPrimers live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
ChargingEntryPrimers live feed.



BlastLogic OData Service Help Documentation

26 2. OData Feeds

2.14 Density measurements

Note: The DensityMeasurements feeds require the View blasts permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The DensityMeasurementslive and synchronisation feeds contain an item for each density

measurement in the specified site.

Note: Measurements of excluded charging events are not included.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

LoadedDeckId Integer Y The primary key of the charging event.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

ProductId Integer N The primary key of the loaded product.

ProductName Text N The name of the loaded product.

Timestamp Date
Time

N The date and time when the measurement was taken.

Density Number kg/m3 N The density of the product recorded by this measurement.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
DensityMeasurements live feed.

Deleted Boolean Y True if the entry was created and has since been cancelled.

Note: This property is not applicable to the
DensityMeasurements live feed.
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2.15 Dipping entries

Note: The DippingEntries feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The DippingEntries live and synchronisation feeds contain an item for each dip sheet entry in the

site.

Note: Cancelled dipping entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the dip sheet.

SheetName Text Y The name of the dip sheet.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

CreatedTime Date
Time

N The date and time when the entry was created.

DippingStartedTime Date
Time

N The date and time when measuring started.

DippingCompletedTime Date
Time

Y The date and time when measuring was completed.

CrewName Text N The name of the crew that measured the hole.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

LastKnownDepth Number m N The last known actual length when the entry was
created.

LastKnownDepthTime Date
Time

N The date and time when the last known depth was
measured.

DipDepth Number m N The measured dip depth.

Water Number m N The measured water length.

WetSides Number m N The measured wet sides length.

Temperature Number K N The measured temperature.

Comment Text N The comment entered by the crew.

SupervisorName Text N The name of the person supervising the person
measuring the hole.

SupervisorDipDepth Number m N The dip depth as measured by the supervisor.

SupervisorDipRequired Boolean N True if the supervisor needs to dip this hole.
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Property name Type Unit Filterable Description

RefreshedTime Date
Time

Y The last time the update or refresh job altered this
row.

Note: This property is not applicable to the
DippingEntries live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
DippingEntries live feed.

2.16 Dip sheets

Note: The DipSheets feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The DipSheets live and synchronisation feeds contain summary data for all dip sheets in the site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text Y Name of the dip sheet.

BlastNames Text Y The comma-separated list of blasts
covered by the sheet.

Instructions Text Y The instructions for the crew.

CreatedTime Date
Time

Y The date and time when the sheet
was created.

CreatedBy Text Y The person who created the sheet.

ShowWater Boolean Y Indicates whether to show theWater
column on the printed sheet.

ShowWetSides Boolean Y Indicates whether to show theWet
sides column on the printed sheet.

ShowTemperature Boolean Y Indicates whether to show the
Temperature column on the printed
sheet.

ShowLast
KnownLength

Boolean Y Indicates whether to show the Last
known length column on the printed
sheet.

ShowTarget
DrillDepth

Boolean Y Indicates whether to show the Target
drill depth column on the printed
sheet.

ShowTarget
ChargeDepth

Boolean Y Indicates whether to show the target
charge depth on the tablet dip sheet.

HoleCount Integer Y The number of holes or entries,
including abandoned holes.
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Property name Type Unit Filterable Description

HoleDippedCount Integer Y The number of completed holes or
entries.

EntryCancelledCount Integer Y The number of abandoned holes or
cancelled entries.

RefreshedTime Date
Time

Y The last time the update or refresh
job altered this row.

Note: This property is not
applicable to the DipSheets live feed.

2.17 Drilling entries and drilling entries stable

Note: The DrillingEntries and DrillingEntriesStable feeds require the View blasts

permission. To manage site permissions, see 6.2.3 Authorisation on page 75.

The DrillingEntries and DrillingEntriesStable live and synchronisation feeds contain data for all

drilling entries in the site.

The DrillingEntriesStable feeds provide the same properties as the DrillingEntries live and

synchronisation feeds but without the custom blast properties, which makes the schema stable in

the face of changes to the BlastLogic drilling custom properties. This can be useful for OData

clients, such as Microsoft Excel PowerQuery, that do not handle schema changes smoothly.

Property name Type Unit Filterable Description

Id Integer Y The primary key of the entry.

HoleId Integer Y The primary key of the hole.

HoleName Text The name of the hole (from the hole, not the
entry).

BlastName Text Y The name of the blast that contains this hole.

Status Text N The following status types can be assigned
to drilling entries:

Designed
Cancelled
Drilled

CreatedTime Date
Time

N The date and time when the entry was
created.

DrillingStartedTime Date
Time

N The date and time when drilling started.

DrillingCompletedTime Date
Time

Y The date and time when drilling was
completed.

MachineName Text Y The drill rig that drilled the hole.

OperatorName Text Y The operator that drilled the hole.
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Property name Type Unit Filterable Description

Comment Text N The comment added to the entry.

PlanCollarX Number Site
coordinate
system

N The plan collar X coordinate at the time the
entry was created.

PlanCollarY Number Site
coordinate
system

N The plan collar Y coordinate at the time the
entry was created.

PlanCollarZ Number Site
coordinate
system

N The plan collar Z coordinate at the time the
entry was created.

PlanAngle Number Degrees from
vertical

N The plan angle at the time the entry was
created.

PlanBearing Number Degrees
clockwise
from north

N The plan bearing at the time the entry was
created.

PlanDepth Number m N The plan depth at the time the entry was
created.

PlanDiameter Number m N The plan diameter at the time the entry was
created.

PlanDrillCost Decimal N The cost per meter to drill a hole of the
PlanDiameter.

ActualCollarX Number Site
coordinate
system

N The collar X coordinate as drilled.

ActualCollarY Number Site
coordinate
system

N The collar Y coordinate as drilled.

ActualCollarZ Number Site
coordinate
system

N The collar Z coordinate as drilled.

ActualAngle Number Degrees from
vertical

N The angle as drilled.

ActualBearing Number Degrees
clockwise
from north

N The bearing as drilled.

ActualDepth Number m N The depth as drilled.

ActualDiameter Number m N The diameter as drilled.

ActualDrillCost Decimal N The cost per meter to drill a hole of the
ActualDiameter.

OperatorDipDepth Number m N The operator dip depth.

TargetDrillDepth Number m N The target drill depth with respect to the
current hole drill design. Uses the collar Z
and angle from the completed drilling entry
or latest survey if available.

Note: TargetDrillDepth is only present
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Property name Type Unit Filterable Description

for completed entries.

DrillDepthError Number m N The actual drill depth less the target drill
depth with respect to the current hole drill
design. The actual drill depth could be the
supervisor dip depth, operator dip depth, or
actual depth.

Note: DrillDepthError is only present
for completed entries.

SetupError Number m N The error in the toe position of a hole due to
errors in setup of the hole during drilling with
respect to the current hole drill design. Uses
the latest survey entry angle and bearing
where available.

Note: SetupError is only present for
completed entries.

CollarError Number m N The horizontal collar error with respect to the
current hole drill design. Uses the latest
survey entry collar where available.

Note: CollarError is only present for
completed entries.

CollarZError Number m N The vertical collar error with respect to the
current hole drill design. Uses the latest
survey entry collar where available.

Note: CollarZError is only present for
completed entries.

OverUnderDrill Text N Compares the DrillDepthError with the Site
Settings drill depth error tolerance. The
following status types can be assigned to the
OverUnderDrill:

Over
Under
WithinTolerance
Null

Note: OverUnderDrill is only present
for completed entries.

DrillingDuration Number Minutes N Indicates how long it took to drill the hole.

PenetrationRate Number m/minute N Not available when the drilling start time is
null or the start or end times are inexact.

Shift String N The drilling shift when drilling was
completed.

SupervisorDipDepth Number m N The supervisor dip depth.

<Custom Properties> Degrees for
angle type
numbers. SI
units for all

Y As defined in the drilling properties in site
settings. See Custom Properties for details.

Note: Custom properties are not
applicable to the DrillingEntriesStable live
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Property name Type Unit Filterable Description

others. and synchronisation feeds.

RefreshedTime Date
Time

Y The last time the update or refresh job
altered this row.

Note: This property is not applicable to
the DrillingEntries and DrillingEntriesStable
live feeds.

2.18 Drilling events and drilling events stable

Note: The DrillingEvents and DrillingEventsStable feeds require the View blasts

permission. To manage site permissions, see 6.2.3 Authorisation on page 75.

The DrillingEvents and DrillingEventsStable live and synchronisation feeds contain data for all

drilling events in the site.

The DrillingEventsStable live and synchronisation feeds provide the same properties as the

DrillingEvents live and synchronisation feeds but without the custom blast properties, which makes

the schema stable in the face of changes to the BlastLogic drilling custom properties. This can be

useful for OData clients, such as Microsoft Excel PowerQuery, that do not handle schema changes

smoothly.

Property name Type Unit Filterable Description

Id Integer Y The primary key of the entry.

HoleId Integer Y The primary key of the hole (if
associated).

HoleName Text N The name of the hole (from the
hole, not the event), if associated.

BlastName Text Y The name of blast that contains this
hole (if associated).

Type Text N The source of the drilling event. The
source can be either Imported or
Tablet.

DrillingEntryId Integer Y The primary key of the drilling entry
that references this event (if any).

StartTime Date Time Site time
zone

N The date and time when the drilling
started.

EndTime Date Time Site time
zone

Y The date and time when the drilling
was completed.

MachineName Text Y The drill rig that drilled the hole.

OperatorName Text Y The operator that drilled the hole.

LocationX Number Site N The collar X coordinate as drilled.
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Property name Type Unit Filterable Description

coordinate
system

LocationY Number Site
coordinate
system

N The collar Y coordinate as drilled.

LocationZ Number Site
coordinate
system

N The collar Z coordinate as drilled.

Depth Number m N The depth as drilled.

Bearing Number Degrees
clockwise
from north

N The bearing as drilled.

Angle Number Degrees
from vertical

N The angle as drilled.

Diameter Number m N The diameter as drilled.

OperatorDipDepth Number m N The operator dip depth.

Comment Text N The comment on the event.

UniqueId Text N The unique identifier of the event in
the source system.

SourceHoleName Text N The name of the hole as defined by
the source system.

<Custom
Properties>

Degrees for
angle type
numbers.
SI units for
all others.

Y As defined the in drilling
properties in site settings.

Note: Custom properties are
not applicable to the
DrillingEventsStable live and
synchronisation feeds.

RefreshedTime Date
Time

Y The last time the update or refresh
job altered this row.

Note: This property is not
applicable to the DrillingEvents and
DrillingEventsStable live feeds.
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2.19 Drilling shift totals

Note: The DrillingShiftTotals feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The DrillingShiftTotals live and synchronisation feeds contain an item for each unique combination

of shift, blast, and drill machine in which one or more holes were drilled.

The DrillingShiftTotals feeds have the following characteristics:

The feed data is taken from validated drilling entries only.

Drilling events that have not been associated and validated are not included.

A maximum of 1000 items can be retrieved per request. Requests should filter by Shift and/or

BlastName.

Note: The DrillingShiftTotals synchronisation feed is an aggregate feed. It executes a query

based on the content of the data warehouse (DW) feed. It does not retrieve data from the

corresponding live feed. The data between the two feeds may differ.

Property name Type Unit Filterable Description

Shift Text Y The shift in which hole drilling was completed.

Example: 2017-02-28 Day

BlastName Text Y The name of the blast that the hole is a
member of.

DrillMachineName Text N The name of the drill machine that drilled the
hole.

DepthDrilled Number m N The total length of all holes drilled.

HolesDrilled Integer N The total number of holes drilled.

HolesUnderDrilled Integer N The number of holes that were underdrilled
with respect to the drill depth tolerance.

HolesOverDrilled Integer N The number of holes that were overdrilled with
respect to the drill depth tolerance.

UnderDrill Number m N The total under drill ignoring tolerances.

OverDrill Number m N The total over drill ignoring tolerances.

DrillingDuration Number Minutes N The total time spent drilling.

Note: Drilling entries without exact times
are excluded.

AveragePenetrationRate Number m/minute N The total time spent drilling divided by depth
drilled.

Note: Drilling entries without exact times
are excluded.
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2.20 Hole anomalies
The HoleAnomalies live feed contains information about anomalies recorded on holes.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleId Integer Y The Id of the hole that the anomaly references.

HoleName Text Y The name of the referenced hole.

BlastName Text Y The name of the blast that contains the hole.

CreatedTime Date
Time

Y The date and time when the anomaly was recorded.

Comment Text Y The anomaly message.
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2.21 Hole snapshots
The HoleSnapshots live and synchronisation feeds contain information on holes at a given point in

time.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleId Integer Y The id of the hole that this hole snapshot
captures.

HoleName Text Y The name of the hole that this hole snapshot
captures.

BlastId Number Y The ID of the blast that the captured hole belongs
to.

BlastName Text Y The name of the blast that the captured hole
belongs to.

SnapshotName Text Y The name of the blast snapshot.

Time Date N The date when the snapshot was created.

CollarX Number Site coordinate
system

N The X coordinate of the hole collar when the
snapshot was captured.

CollarY Number Site coordinate
system

N The Y coordinate of the hole collar when the
snapshot was captured.

CollarZ Number Site coordinate
system

N The Z coordinate of the hole collar when the
snapshot was captured.

Type Text Y The type of snapshot. Currently, only the design
snapshot type is provided through OData.

Depth Number m N The depth of the hole when the snapshot was
captured.

Angle Number Degrees from
vertical

N The angle of the hole when the snapshot was
captured.

Bearing Number Degrees
clockwise from
north

N The bearing of the hole when the snapshot was
captured.

Diameter Number m N The diameter of the hole when the snapshot was
captured.

Burden Number m N The burden of the hole when the snapshot was
created.

Spacing Number m N The spacing of the hole when snapshot was
created.

WetSidesLength Number m N The length of wet sides in the hole when the
snapshot was captured.

WaterLength Number m N The length of water in the hole when snapshot
was created.

ChargeStandoff Number m N The charge standoff of the hole when the
snapshot was created.
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Property name Type Unit Filterable Description

ChargeDepth Number m N The depth of charge in the hole when the
snapshot was created.

DeckCount Integer N The number of decks in the hole when the
snapshot was created.

PrimerCount Integer N The number of primers in the hole when the
snapshot was created.

Deleted Boolean Y True if the snapshot is no longer a reference
design.

Note: This property is not applicable to the
HoleSnapshots live feed.

RefreshedTime Date
Time

Y The date and time when this row was last
updated in data warehouse.

Note: This property is not applicable to the
HoleSnapshots live feed.

2.22 Hole snapshot decks
The HoleSnapshotDecks live and synchronisation feeds contain information on hole snapshot

decks contained within hole snapshots.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleSnapshotId Integer Y The ID of the hole that the snapshot this belongs to.

BlastProductId Integer N The ID of the blast product that is used in this
snapshot.

Length Number N The length of the charge in this snapshot.

ProductMass Number N The mass of the product in this snapshot.

Quantity Number N The quantity of product in this snapshot.

Order Integer N The order of the product in the hole in this snapshot.

Deleted Boolean Y True if the snapshot is no longer a reference
design.

Note: This property is not applicable to the
HoleSnapshotDecks live feed.

RefreshedTime Date
Time

Y The date and time when this row was last updated
in data warehouse.

Note: This property is not applicable to the
HoleSnapshotDecks live feed.
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2.23 Hole snapshot primers
The HoleSnapshotPrimers live and synchronisation feeds contain information on primers contained

within hole snapshots.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleSnapshotId Integer Y The ID of the hole snapshot that this belongs to.

BlastProductIdList Text N The list of blast product IDs used in this snapshot.

Depth Number N The depth of the primer in the hole in this snapshot.

Deleted Boolean Y True if the snapshot is no longer a reference design.

Note: This property is not applicable to the
HoleSnapshotPrimers live feed.

RefreshedTime Date
Time

Y The date and time when this row was last updated in data
warehouse.

Note: This property is not applicable to the
HoleSnapshotPrimers live feed.

2.24 Holes and holes stable

Note: The Holes and HolesStable feeds require the View blasts permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The Holes and HolesStable live and synchronisation feeds contain data for all holes in the site.

The HolesStable live and synchronisation feeds provide the same properties as the Holes live and

synchronisation feeds but without the custom blast properties, which makes the schema stable in

the face of changes to the BlastLogic hole custom properties. This can be useful for OData clients,

such as Microsoft Excel PowerQuery, that do not handle schema changes smoothly.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text N The name of the hole.

BlastName Text Y The name of the blast that contains this
hole.

BlastId Integer Y The ID of the blast that contains this
hole.

Row Text N The blast row.

Echelon Integer N The blast echelon.

Status Text N The following status types can be
assigned to holes:
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Property name Type Unit Filterable Description

Designed
Drilled
Dipped
Backfilled
Partially Charged
Charged
Fired
Abandoned

LastKnownDepth Number m N The last known actual depth
measurement, which includes dip,
backfill, and charge entry
measurements.

LastKnownWater Number m N The last known water measurement,
which includes dip, backfill, and charge
entry measurements.

LastKnownWetSides Number m N The last known wet sides
measurement, which includes dip,
backfill, and charge entry
measurements.

LastKnownTemperature Number K N The last known temperature
measurement, which includes dip,
backfill, and charge entry
measurements.

LastKnownTemperatureTime Date
Time

Site time
zone

N The time of completing the last known
temperature measurement, which
includes dip, backfill, and charge entry
measurements.

PreviousTemperature Number K N The temperature measurement prior to
the last known temperature.

PreviousTemperatureTime Date
Time

Site time
zone

N The time of completing the temperature
measurement prior to the last known
temperature.

TemperatureRateOfChange Number K/day N The rate of change of temperature
between the last known and previous
temperatures.

DesignTime Date
Time

Y The date and time when the hole was
designed or created.

DrilledTime Date
Time

N The date and time when the hole was
drilled (the end time).

LastDipDepth Number m N The dip depth from the most recent
completed dipping entry.

LastDippedTime Date
Time

N The time of completing the most recent
dipping entry.

LastBackfillingDipDepth Number m N The most recently measured dip depth
(before or after) from a backfilling entry.

LastBackfillingDipTime Date
Time

N The time of completing the most recent
dip depth measurement (before or
after) from a backfilling entry.
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Property name Type Unit Filterable Description

LastChargingDipDepth Number m N The dip depth from the charging entry
with the most recently completed dip
section.

LastChargingDipTime Date
Time

N The time of completing the charging
entry with the most recently completed
dip section.

ChargedTime Date
Time

N The date and time when the hole was
flagged as charged or reconciled.

FiredTime Date
Time

N The date and time when the hole was
fired.

AbandonedTime Date
Time

N The date and time when the hole was
abandoned.

AbandonedComment Text N The comment explaining why the hole
was abandoned.

Misfire Boolean N Indicates whether the hole potentially
misfired.

MisfireComment Text N The comment for the potential misfire.

RedrillOfHoleId Integer Y The ID of the hole that this hole is a re-
drill of.

RedrillOfHoleName Text N The name of the hole that this hole is a
re-drill of.

IsAdHoc Boolean N Indicates whether the hole is an ad hoc
hole (that is, the drill design values are
blank and the active drilling entry
values are blank).

DesignCollarX Number Site
coordinate
system

N The collar design (X coordinate).

DesignCollarY Number Site
coordinate
system

N The collar design (Y coordinate).

DesignCollarZ Number Site
coordinate
system

N The collar design (Z coordinate)

DesignAngle Number Degrees
from vertical

N The ideal angle specified by a drill and
blast engineer before any real world
data has been provided.

DesignBearing Number Degrees
clockwise
from north

N The ideal bearing specified by a drill
and blast engineer before any real
world data has been provided.

DesignDepth Number m N The ideal depth specified by a drill and
blast engineer before any real world
data has been provided.

DesignDiameter Number m N The ideal diameter specified by a drill
and blast engineer before any real
world data has been provided.
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Property name Type Unit Filterable Description

DesignBurden Number m N The ideal burden specified by a drill and
blast engineer before any real world
data has been provided.

DesignSpacing Number m N The ideal spacing specified by a drill
and blast engineer before any real
world data has been provided.

DesignDrillCost Decimal N The per-metre cost of drilling a hole of
this design diameter.

ActualCollarX Number Site
coordinate
system

N The latest known collar X.

ActualCollarY Number Site
coordinate
system

N The latest known collar Y.

ActualCollarZ Number Site
coordinate
system

N The latest known collar Z.

TargetChargeDepth Number m N The target charge depth.

PlannedPrimerCount Number N The number of primers planned (or
designed if no active charging entry
exists).

LoadedPrimerCount Number N The number of primers loaded (or
reconciled for reconciled holes).

LoadedExplosive
DeckCount

Number N The number of explosive decks loaded
(or reconciled for reconciled holes).

Note: Adjacent or overlapping
decks of the same product are counted
as distinct decks.

DrilledOutsideCollar
Tolerance

Boolean N True if drilled outside Collar XY
tolerance, false if drilled within
tolerance, and null if cannot not be
determined (for example, the hole has
not been drilled or has no design).

DippedOutsideCharge
DepthTolerance

Boolean N True if the last known depth (excluding
drilled depth and design depth) less the
target charge depth is outside the
charge depth error tolerance, false if
within tolerance, and null if cannot not
be determined (for example, when the
hole has not been dipped).

Note: Dip measurements can be
sourced from drilling entries (operator
or supervisor), dip sheets, backfill
sheets or charge sheets.

ChargedOutsideMass
Tolerance

Boolean N True if the absolute difference between
the reconciled charge mass and the
design charge mass exceeds the
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Property name Type Unit Filterable Description

charge sheet mass tolerance multiplied
by the design charge mass, false if it is
not exceeded, and null if it cannot be
determined (for example, when the
charge has not been reconciled or if the
sheet has no charge mass tolerance
set).

Note: Holes must have a charged,
reconciled charging entry to be
considered for this calculation.

TopMostStemming
DeckLoaded

Boolean N True if a loaded (or reconciled for
reconciled holes) deck exists with a
product type equivalent to the topmost
planned (or designed) inert deck and
they overlap.

Note: Stemming and drill cutting
product types are considered
equivalent.

StemmedOutside
LengthTolerance

Boolean N True if the absolute length difference
between the topmost planned
stemming deck and the closest
reconciled stemming deck exceeds the
charge sheet stemming length
tolerance, false if the difference is less
than the tolerance, and null if it cannot
be determined (for example, when the
charge is not reconciled, the tolerance
is not set, the plan does not include a
stemming deck, or there are no
reconciled stemming decks).

Note: The closest reconciled deck
is identified as the deck closest to the
planned deck by depth mid-point.

Note: A stemming deck is defined
as a deck of product type stemming or
drill cuttings.

ExplosiveMassDesigned Number kg N The total mass of all designed or
planned explosive decks, or null if no
charge design exists.

ExplosiveMassLoaded Number kg N The total mass of all loaded explosive
decks (typically entered using the
BlastLogic Tablet), or null if no decks
have been loaded.

ExplosiveMassReconciled Number kg N The total mass of all reconciled
explosive decks, or null if the hole is not
charged or reconciled.

StemmingLengthDesigned Number m N The total length of all designed or
planned stemming decks, or null if no
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Property name Type Unit Filterable Description

charge design exists.

StemmingLengthLoaded Number m N The total length of all loaded stemming
decks (typically entered using the
BlastLogic Tablet), or null if no decks
have been loaded.

StemmingLength
Reconciled

Number m N The total length of all reconciled
stemming decks, or null if the hole is not
charged or reconciled.

DesignTieUpCount Number N The number of design tie-ups that
include this hole.

ActualTieUpCount Number N The number of actual tie-ups that
include this hole.

ChargeStandoff Number N The charge standoff of the hole charge
design.

ChargeStandoffDirection Number N The charge standoff direction of the
hole charge design.

<Custom Properties> String Degrees for
angle type
numbers. SI
units for all
others.

Y As defined in site settings. See Custom
Properties for details.

Note: Custom properties are not
applicable to the HolesStable live and
synchronisation feeds.

RefreshedTime Date
Time

Y The last time the update or refresh job
altered this row.

Note: This property is not
applicable to the Holes and
HolesStable live feeds.
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2.25 Inventory changes

Note: The InventoryChanges feeds require the View inventory permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The InventoryChanges live and synchronisation feeds contain an item for every inventory change

recorded in the specified site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Time Date
Time

Site
time
zone

Y The date and time when the
change occurred.

Activity Text Y An activity can be classified as
follows:

Stocktake
Received
Dispatched
Adjustment
Check In
Check Out

ProductId Integer Y The primary key of the blast
product.

ProductName Text N The name of the blast product.

ProductChange Number N The change in stock level.

ProductStockLevel Number N The stock level after the
change.

ProductComment Text N The product line item comment.

BlastId Integer N The primary key of the blast
associated with the inventory
change.

BlastName Text N The name of the blast
associated with the inventory
entry change.

Reference Text N The inventory change
reference.

Comment Text N The inventory change
comment.

ChangeBy Text N The name of the person to
whom the change was
attributed.

EnteredBy Text N The user name of the person
that entered the change.

MagazineId Integer Y The primary key of the
magazine.
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Property name Type Unit Filterable Description

MagazineName Text Y The name of the magazine.

RefreshedTime Date
Time

Y The last time the update or
refresh job altered this row.

Note: This property is not
applicable to the
InventoryChanges live feed.

2.26 Loaded decks

Note: The LoadedDecks feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The LoadedDecks live and synchronisation feeds contain an item for every deck recorded as

loaded in the site (that is, for deck charging events).

Note: Deleted decks are not included in the feed.

The items in the LoadedDecks feeds represent the raw data entered using the BlastLogic Tablet by

the charge crew. The completeness and accuracy of this data may vary depending on the work

practices, available resources, and diligence of the charge crew. This data is subsequently

reconciled against the charge plan by the engineer using the Charge Data Entry panel in the

BlastLogic Desktop application. An algorithm is used to assist the engineer to correct common

charge crew data entry mistakes like duplicate, overlapping, or missing decks.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

StartTime Date
Time

N The date and time when the loading started, or the start time
of the shift if unknown.

EndTime Date
Time

Y The date and time when the loading was completed, or the
end time of the shift if unknown.

HoleId Integer Y The primary key of the hole.

HoleName Text Y The name of the hole when the deck was loaded.

BlastName Text Y The name of the blast that the hole is a member of.

ProductId Integer N The primary key of the product to load.

ProductName Text N The name of the loaded product.

Mass Number kg N The mass loaded, or the planned mass if not recorded.

Top Number m N The depth of the top of the deck, or the planned top if not
recorded.

Bottom Number m N The depth of the bottom of the deck, or the planned bottom if
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Property name Type Unit Filterable Description

not recorded.

Quantity Integer N The number of units loaded (for packaged products only), or
the planned quantity if not recorded.

Cost Decimal N The cost per unit of the product.

Comment Text N The comments from the crew or operator.

ShotfirerName Text N The name of the shotfirer supervising the crew loading the
decks.

CrewName Text N The name of the crew loading the decks.

OperatorName Text N The name of the person operating the charging truck, loading
truck, or mobile mixing unit (MMU).

TruckName Text N The name of the charging truck, loading truck, or mobile
mixing unit (MMU).

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
LoadedDecks synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
LoadedDecks live feed.

Deleted Boolean Y True if the entry was created and has since been cancelled.

Note: This property is not applicable to the
LoadedDecks live feed.

2.27 Loaded primers

Note: The LoadedPrimers feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The LoadedPrimers live and synchronisation feeds contain an item for every primer loaded in the

site (that is, for primer charging events).

Note: Deleted primers are not included in the feed.

The items in the LoadedPrimers feeds represent the raw data entered using the BlastLogic Tablet

by the charge crew, or the data entered by an engineer using the Load Primers tool in the

BlastLogic Desktop application. The completeness and accuracy of this data will vary depending on

the work practices, available resources, and diligence of the charge crew and engineers. This data

is subsequently reconciled against the charge plan by the engineer using the Charge Data Entry

panel in the BlastLogic Desktop application. An algorithm is used to assist the engineer to correct

common data entry mistakes like duplicated and missing primers.
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Property name Type Unit Filterable Description

Id Integer Y The primary key.

StartTime Date
Time

N The date and time when the loading started, or the start time
of the shift if unknown.

EndTime Date
Time

Y The date and time when the loading was completed, or the
end time of the shift if unknown.

HoleId Integer Y The primary key of the hole.

HoleName Text Y The name of the hole when the deck was loaded.

BlastName Text Y The name of the blast that the hole is a member of.

ProductIds Text N The comma-separated list of the primer product primary
keys.

ProductNames Text N The comma-separated list of the names of the primer
products.

Depth Number m N The depth of the primer, or the plan depth if not recorded.

Comment Text N The comments from the crew or operator.

ShotfirerName Text N The name of the shotfirer supervising the crew loading the
decks.

CrewName Text N The name of the crew loading the decks.

OperatorName Text N The name of the person operating the charging truck, loading
truck, or mobile mixing unit (MMU).

TruckName Text N The name of the charging truck, loading truck, or mobile
mixing unit (MMU).

Cost Decimal N The cumulative cost of all primer products.

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
LoadedPrimers synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
LoadedPrimers live feed.

Deleted Boolean Y True if the entry was created and has since been cancelled.

Note: This property is not applicable to the
LoadedPrimers live feed.
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2.28 Reconciled decks

Note: The ReconciledDecks feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The ReconciledDecks live and synchronisation feeds contain an item for every reconciled (actual)

deck in the site.

Reconciled decks can originate from the following:

Decks loaded using the BlastLogic Tablet client.

The charge reconciliation process when it can infer that a plan deck has been loaded.

Decks entered manually by an engineer to correct errors or omissions.

Reconciled decks will not be present until an engineer completes the charge reconciliation process,

which typically takes place after the blast is fired.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleId Integer Y The primary key of the hole.

HoleName Text Y The name of the hole.

BlastName Text Y The name of the blast that the hole is a member of.

ProductId Integer N The primary key of the product.

ProductName Text N The name of the product.

Mass Number kg N The mass of the product.

Top Number m N The depth of the top of the deck.

Length Number m N The length of the deck.

Quantity Integer N The number of units loaded (for packaged products only).

Cost Decimal N The cost per unit of the product.

LoadedDeckId Integer N The primary key of the underlying loaded deck for decks
originating from a loaded deck.

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
ReconciledDecks synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
ReconciledDecks live feed.

Deleted Boolean Y True if the entry was created and has since been cancelled.

Note: This property is not applicable to the
ReconciledDecks live feed.
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2.29 Reconciled primers

Note: The ReconciledPrimers feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The ReconciledPrimers live and synchronisation feeds contain an item for every reconciled (actual)

primer in the site.

Reconciled primers may originate from the following:

Primers loaded using the BlastLogic Tablet client.

The charge reconciliation process when it can infer that a plan primer has been loaded.

Primers entered manually by an engineer to correct errors or omissions.

Reconciled primers will not be present until an engineer completes the charge reconciliation

process, which typically takes place after a blast is fired.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

HoleId Integer Y The primary key of the hole.

HoleName Text Y The name of the hole.

BlastName Text Y The name of the blast that the hole is a member of.

ProductIds Text N The comma-separated list of the primer product primary
keys.

ProductNames Text N The comma-separated list of the names of the primer
products.

Depth Number m N The depth of the primer, or the plan depth if not recorded.

LoadedPrimerId Integer N The primary key of the underlying loaded primer for primers
originating from a loaded primer.

Cost Decimal N The cumulative cost of the products compromising the
primer.

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
ReconciledPrimers synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
ReconciledPrimers live feed.

Deleted Boolean Y True if the entry was created and has since been cancelled.

Note: This property is not applicable to the
ReconciledPrimers live feed.
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2.30 Site parameters

Note: To use the SiteParameters feeds, you need to be a user of a given site. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The SiteParameters live and synchronisation feeds expose site information and site setting values

for the selected site. There is only one item available in the SiteParameters feed. Consequently, you

can only have one set of site parameters for a site.

Property name Type Unit Filterable Description

Name Text N/A The name of the site.

Code Text N/A The code for the site.

TimeZoneName Text N/A The time zone used at the site in the time zone
database format, for example
Australia/Adelaide.

CollarZTolerance
LowerBound

Double m N/A The allowed deviation between the as-drilled
collar Z and the design collar Z lower bound
(for the default hole diameter).

CollarZTolerance
UpperBound

Double m N/A The allowed deviation between the as-drilled
collar Z and the design collar Z upper bound
(for the default hole diameter).

CollarErrorTolerance Double m N/A The collar error allowed in the drilling process
(for the default hole diameter).

DrillDepthErrorTolerance
LowerBound

Double m N/A The allowed range of hole depth errors in the
drilling process (lower bound, for the default
hole diameter).

DrillDepthErrorTolerance
UpperBound

Double m N/A The allowed range of hole depth errors in the
drilling process (upper bound, for the default
hole diameter).

DipDepthTolerance Double m N/A The maximum allowance of error for dip
measurements (for the default hole diameter).

ChargeDepthTolerance
LowerBound

Double m N/A The allowed hole charge depth error (lower
bound).

ChargeDepthTolerance
UpperBound

Double m N/A The allowed hole charge depth error (upper
bound), also known as the backfill tolerance
(for the default hole diameter).

DesignedHoleColour Text N/A The colour in which to display designed holes
in #RRGGBB format.

DrilledHoleColour Text N/A The colour in which to display drilled holes in
#RRGGBB format.

DippedHoleColour Text N/A The colour in which to display dipped holes in
#RRGGBB format.

BackfilledHoleColour Text N/A The colour in which to display backfilled holes
in #RRGGBB format.
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Property name Type Unit Filterable Description

PartiallyCharged
HoleColour

Text N/A The colour in which to display partially
charged holes in #RRGGBB format.

ChargedHoleColour Text N/A The colour in which to display charged
(reconciled) holes in #RRGGBB format.

FiredHoleColour Text N/A The colour in which to display fired holes in
#RRGGBB format.

AbandonedHoleColour Text N/A The colour in which to display abandoned
holes in #RRGGBB format.

CoordinateSystemProjString Text N/A The PROJ.4 proj-string used to convert
between GNSS coordinates and the local
mine grid (see https://proj4.org for
specifications).

LocalTransformHorizontal
OriginX

Number m N/A The horizontal local transformation origin X
value.

LocalTransformHorizontal
OriginY

Number m N/A The horizontal local transformation origin Y
value.

LocalTransformHorizontal
Rotation

Number rad N/A The horizontal local transformation rotation
angle.

LocalTransformHorizontal
TranslationX

Number m N/A The horizontal local transformation X
translation/shift.

LocalTransformHorizontal
TranslationY

Number m N/A The horizontal local transformation Y
translation/shift.

LocalTransformHorizontal
ScaleFactor

Number N/A The horizontal local transformation horizontal
scale factor.

LocalTransformVertical
OriginX

Number m N/A The vertical local transformation origin X
value.

LocalTransformVertical
OriginY

Number m N/A The vertical local transformation origin Y
value.

LocalTransformVertical
SlopeRatioX

Number N/A The vertical local transformation X slope ratio.

LocalTransformVertical
SlopeRatioY

Number N/A The vertical local transformation Y slope ratio.

LocalTransformVertical
Translation

Number m N/A The vertical local transformation
translation/shift.

CostParametersDefault
BulkExplosiveCostPerKg

Decimal N/A The default cost of bulk explosive per
kilogram.

CostParametersDefault
DrillingCostPerMetre

Decimal N/A The default cost of drilling per metre.

CostParametersDefault
PrimerCostPerDeck

Decimal N/A The default cost of primers per deck.

CostParametersFixed
ChargingCostPerHole

Decimal N/A The default cost of charging a hole.

CostParametersFixed
DrillingCostPerHole

Decimal N/A The default fixed costs of drilling a hole.

https://proj4.org/
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2.31 Surveying entries

Note: The SurveyingEntries feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The SurveyingEntries live and synchronisation feeds contain an item for each survey sheet entry in

the site.

Note: Cancelled surveying entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the survey sheet.

SheetName Text Y The name of the survey sheet.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

CreatedTime Date
Time

N The date and time when the entry was created.

SurveyedTime Date
Time

N The date and time when surveying was
performed.

SurveyorName Text N The name of the person that surveyed the hole.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

SurveyCollarX Number Site coordinate
system

N The surveyed Collar X coordinate.

SurveyCollarY Number Site coordinate
system

N The surveyed Collar Y coordinate,

SurveyCollarZ Number Site coordinate
system

N The surveyed Collar Z coordinate.

SurveyAngle Number Degrees from
vertical

N The surveyed angle.

SurveyBearing Number Degrees clockwise
from north

N The surveyed bearing.

Comment Text N The comment entered by the surveyor.

RefreshedTime Date
Time

Y The last time the update or refresh job altered
this row.

Note: This property is not applicable to the
SurveyingEntries live feed.

Deleted Boolean Y True if the entry was created and has since
been cancelled.

Note: This property is not applicable to the
SurveyingEntries live feed.
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2.32 Survey sheets

Note: The SurveySheets feeds require the View blasts permission. To manage site

permissions, see 6.2.3 Authorisation on page 75.

The SurveySheets live and synchronisation feeds contain summary data for all survey sheets in the

site.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

Name Text Y The name of the survey sheet.

BlastNames Text Y The comma-separated list of blasts covered by the
sheet.

Instructions Text Y The instructions for the crew.

CreatedTime Date
Time

Y The date and time when the sheet was created.

CreatedBy Text Y The person who created the sheet.

HoleCount Integer Y The number of holes or entries, including abandoned
holes.

HoleSurveyedCount Integer Y The number of completed holes or entries.

EntryCancelledCount Integer Y Number of abandoned holes or cancelled entries.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
SurveySheets live feed.
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2.33 Target Charge Plan Decks

Note: The TargetChargePlanDecks feeds require the View blasts permission. To manage

site permissions, see 6.2.3 Authorisation on page 75.

The TargetChargePlanDecks live and synchronisation feeds contain an item for each planned

charge deck in the site.

Note: Decks for cancelled target charge plan entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the charge sheet.

SheetName Text Y The name of the charge sheet.

ChargingEntryId Integer Y The primary key of the charging entry.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

Depth Number m N The charging entry dip depth if available, else the last
known length (effective geometry).

Angle Number Degrees N The last known angle of the hole.

Water Number m N The charging entryWater value if available, else the
last known water value.

WetSides Number m N The charging entryWetSides value if available, else
the last known wet sides value.

Temperature Number K N The charging entry Temperature value if available,
else the last known temperature value.

ChargeRuleName Text N The name of the charge rule used to generate the
plan.

ProductId Integer N The primary key of the product to load.

ProductName Text N The name of the product to load.

PlanMass Number kg N The mass of the product to load.

PlanLength Number m N The length of the deck.

PlanTop Number m N The depth where the top of the deck should come to.

Cost Decimal N The cost per unit of the product used in this deck.

PlanQuantity Integer N The quantity of the packaged product to load.
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Property name Type Unit Filterable Description

LastModified Date
Time

Y The date and time when the entry was last modified.
Note: This property is not applicable to the

TargetChargePlanDecks synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
TargetChargePlanDecks live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
TargetChargePlanDecks live feed.

2.34 Target Charge Plan Primers

Note: The TargetChargePlanPrimers feeds require the View blasts permission. To

manage site permissions, see 6.2.3 Authorisation on page 75.

The TargetChargePlanPrimers live and synchronisation feeds contain an item for each planned

primer in the site.

Note: Primers for cancelled target charge plan entries are excluded from the live feed.

Property name Type Unit Filterable Description

Id Integer Y The primary key.

SheetId Integer Y The primary key of the charge sheet.

SheetName Text Y The name of the charge sheet.

ChargingEntryId Integer Y The primary key of the charging entry.

HoleId Integer Y The primary key of the hole.

HoleName Text N The name of the hole.

BlastName Text Y The blast that the hole is a member of.

Row Text N The row where the hole is positioned.

Echelon Integer N The echelon where the hole is positioned.

Depth Number m N The charging entry dip depth if available, else the last
known length (effective geometry).

Angle Number Degrees N The last known angle of the hole.

Water Number m N The charging entryWater value if available, else the
last known water value.

WetSides Number m N The charging entryWetSides value if available, else
the last known wet sides value.

Temperature Number K N The charging entry Temperature value if available,
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Property name Type Unit Filterable Description

else the last known temperature value.

ChargeRuleName Text N The name of the charge rule used to generate the
plan.

ProductIds Integer N The comma-separated list of the primary keys of the
products comprising the primer.

ProductNames Text N The comma-separated list of the names of the
products comprising the primer.

PlanDepth Number m N The depth at which to load the primer.

Cost Decimal N The cumulative cost of all products comprising the
primer.

LastModified Date
Time

Y The date and time when the entry was last modified.

Note: This property is not applicable to the
TargetChargePlanPrimers synchronisation feed.

RefreshedTime Date
Time

Y The last time the update or refresh job altered this row.

Note: This property is not applicable to the
TargetChargePlanPrimers live feed.

Deleted Boolean Y True if the entry was created and has since been
cancelled.

Note: This property is not applicable to the
TargetChargePlanPrimers live feed.
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3. Custom Properties
The holes, blasts, and drilling properties feeds include properties for the custom properties

configured in the Site Setup panel of the BlastLogic Desktop client (Home tab > Setup group >

Site).

3.1 Multi-select properties
Due to limitations with the OData service implementation, there is a dedicated method to handle

multi-select properties.

Each multi-select custom property is represented by the following OData properties:

An enumeration type property that you can use for filtering is not visible to some clients (for

example, SSIS and Spotfire).

A string property that is visible to all clients but cannot be used for filtering.

Note: Both these OData properties have the same value (a string containing each value

separated by spaces).

3.2 Range properties
The float range properties are represented by the following OData float properties:

A float or double for the lower value.

A float or double for the upper value.
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3.3 Mapping
The table below shows the way the custom properties are mapped.

Custom
property

Example
BlastLogic

Example OData OData type
Returned
as

Filterable
Example
value

Type Custom Property
Identifier

Property Name

Float MyFloatProperty MyFloatProperty float Float Y 5.4

Multi-
select

MyMultiSelect MyMultiSelect enumeration
flags

String-
space
delimited
list

Y (Use the
has
operator.)

"value1
value3"

Multi-
select

MyMultiSelect MyMultiSelect_Text text String-
space
delimited
list

N "value1
value3"

Range MyRangeProperty MyRangeProperty_
Lower

float Float Y 3.2

Range MyRangeProperty MyRangeProperty_
Upper

float Float Y 5.9

Select MySelectProperty MySelectProperty text String Y "value1"

String MyStringProperty MyStringProperty text String Y "some
value"
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4. Microsoft Excel Power
Query Walk Through

Use the information below to view your data with Microsoft Excel Power Query and to identify the

available data feeds.

4.1 Prerequisites
To use Microsoft Excel Power Query, you must meet the following conditions:

Have Microsoft Excel Power Query Installed.
While Microsoft Excel 2016 and newer versions come with the built-in Power Query, you must

download and install the free Power Query add-in from Microsoft if you are using Microsoft

Excel 2010 or 2013.

Be an authorised user.
Users of the BlastLogic OData service must be authorised as users of the BlastLogic Server

and at least one site.

Have the OData service URL.
Where an OData service is available, the service link will be provided in the Help > About >

Session Information tab in the BlastLogic desktop application.

Figure 4-1 Accessing OData service information in the BlastLogic desktop application

Tip: You can also find the OData service link on the server website for your site.
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4.2 Viewing data
Follow these steps to view your OData feed information:

1. Open Microsoft Excel and go to the Data tab > Get & Transform Data group >Get Data

> From Other Sources and select From OData Feed.

Figure 4-2 The path for accessing the OData feed import in Microsoft Excel for Microsoft 365.

Note: The above access path applies to Microsoft Excel for Microsoft 365. OData

feed in other versions of Microsoft Excel might be nested under different menu items.

2. Enter the URL for the site OData service and clickOK.

Note: You can find the OData URL in the Help > About > Session Information tab in

the BlastLogic desktop application (see 4.1 Prerequisites on the previous page for details).
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Figure 4-3 The OData URL entry panel.

3. If you are loading a feed from a site for the first time, theOData feed authentication panel will

appear. Proceed as follows:

For on-premise servers, open theWindows tab and select Use my current credentials

radio button. Next, using the drop-down, select the OData URL that you have entered in

the previous step and click Connect.

Figure 4-4 Connecting OData feed for on-premise servers .

For cloud-hosted servers, open the Basic tab and enter your Microsoft Entra ID user

name and OData User Authentication key as a password (see OData User

Authentication Keys on page 70 for instructions on generating OData authentication

keys). Next, using the drop-down, select the OData URL that you have entered in the

previous step and click Connect.
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Figure 4-5 Connecting OData feed for cloud-hosted servers .

The Navigator panel that lists the OData feeds will open. Select the required OData feed that

you want to preview.

Note
To enable data preview, click Display Options on the left-hand side of the Navigator

panel and select Enable data previews.

Figure 4-6 Enabling data previews in the Navigator
panel .

4.2.1 Filtering data
Due to the size limits of the data that can be loaded in the Navigator panel, the data featured in the

preview can be truncated. However, you can limit the amount of the displayed data by filtering and

sorting it. This allows you to view only the data that you currently need. You can filter your data in

the Power Query Editor either manually or using a query.

Filtering data manually

Follow these steps to filter your data manually in the Power Query Editor:
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1. Select the data feed from the list and click the Transform Data button in the Navigator panel.

Figure 4-7 The Transform Data button in the Navigator panel.

2. The Power Query Editor will open for the selected data feed.

Figure 4-8 The Power Query Editor screen.

Click the button in the header of the column by which you want to filter your data.

3. Clear the (Select All) checkbox.
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Figure 4-9 Clearing the (Select All) checkbox.

Note
Due to the size limits of the data that can be initially loaded in the drop-down shown above,

the list might not contain all items that are included in the given category in your database.

To load all items, click Load more.

Figure 4-10 The Load more button.

Next, select the items that you want to be displayed, and clickOK.
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Figure 4-11 Selecting the items to be displayed (example).

The table in the Power Query Editor will be filtered to include only the selected items.

Figure 4-12 Filtering results applied (example)

To export your results to an external Microsoft Excel Sheet, go to the Home tab > Close & Load.
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Figure 4-13 The Close & Loadmenu item under the Home tab

Select either of the following from the drop-down:

Close & Load: Close the Power Query Editor and load your filtered data to a new Microsoft

Excel Sheet.

Close & Load To...: Specify how the data should be loaded in to a new Microsoft Excel sheet

by selecting the required options from the Import Data panel.

Figure 4-14 The Import Data panel.

Filtering data using queries

When you filter your data using queries, the server filters it before returning the result, which makes

it the most efficient way to filter data.

Important: This filtering method is not applicable to all columns.

Note: If a query is loading tens of thousands of rows, it probably needs to be filtered further.

The server may decline to return all rows for queries that would return an excessive number of

rows.
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Follow these steps to filter the data displayed in the Power Query Editor with a query:

1. Open the Power Query Editor (see step 1 and step 2 of the Filtering data manually on page 62

for details).

2. After clicking the button corresponding in the header of the column by which you want to

filter your data, go to the Text filters... and select the required query type from the list.

Figure 4-15 Query types in Power Query Editor.

3. Based on the number of conditions and filtering complexity that you want to apply to your data,

select one of the following filtering methods:

Basic. Apply up to two filtering conditions by selecting conditions from the drop-downs

and entering the required value to be filtered (either by typing or selecting from the drop-

down). Finish by clickingOK.

Figure 4-16 The Basic filtering method.
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Or

Advanced. Add as many filtering conditions as needed by Clicking Add Clause. Specify

each condition by selecting the required options from the And/Or, Column, and

Operator drop-downs and enter the required value to be filtered in the Value column

(either by typing or selecting from the drop-down). Finish by clickingOK.

Figure 4-17 The Advanced filtering method.

Tip
To delete or reorder the filtering conditions that you have added, click the button and

select the required operation.

Figure 4-18 Deleting and reordering filtering conditions.

To export your results to an external Microsoft Excel Sheet, go to the Home tab > Close &

Load.
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4. Figure 4-19 The Close & Loadmenu item under the Home tab.

Select either of the following from the drop-down:

Close & Load: Close the Power Query Editor and load your filtered data to a new

Microsoft Excel Sheet.

Close & Load To...: Specify how the data should be loaded in to a new Microsoft Excel

sheet by selecting the required options from the Import Data panel.

Figure 4-20 The Import Data panel.

Tip: You can also sort your query results as in any other Excel table. To do so, click the

button corresponding in the header of the required column and select Sort Ascending or
Sort Descending.
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5. OData User
Authentication Keys

Use API keys to access the OData and Extend APIs. Microsoft Entra ID users are required to

generate an OData User Authentication Key that is used instead of their Windows password.

Important: A user authentication key is paired with the user account that created the key to

provide access to OData. Therefore, each user should create their own key.

Note: BlastLogic instances that use Windows authentication are not affected.

5.1 Creating a user authentication key
Follow these steps to generate an API key:

1. Enter the BlastLogic Server Configuration website.

Note: The server URL is unique to each user and has the following form:

<serverURI>/web/,

where <serverURI> corresponds to the URI of the server that you connect to while using

the BlastLogic Desktop application. See the separate documents BlastLogic Server

Installation Procedure and BlastLogic Server and BlastLogic Tablet Licensing Procedure

for more information.

2. Click (API Keys) to enter the API Keys page.
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Figure 5-1 The API Keys page on the Server Configuration website

3. Click the button.

Figure 5-2 Adding a new API key

4. Enter the name for your API key to help you identify the key in future and click Add.

Figure 5-3 Entering the name for the API key

A secure, randomly generated password will be created and displayed.
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Figure 5-4 Displaying the generated API key

Important: We recommend that you make a record of the generated key. The key will only

be visible on the screen immediately after it is generated. When you click Done or leave the API

Keys page and enter it again, only the last three characters will be shown as a hint. The key

cannot be recovered and if you lose it, you will have to generate another.

Note: The User Authentication Key that you have generated can only be used to access

BlastLogic OData services. It will not grant you access to any other component of BlastLogic.

See also: For information on how to use a generated key to log into an OData feed in

Microsoft Excel, see 4.2 Viewing data on page 60.
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6. Technical Guidance
The following section explores some technical and architectural aspects of the BlastLogic OData

service.

We recommend that the following professionals familiarise themselves with this part of the

document:

System architects

Business analysts

Developers

Systems integrators

6.1 OData standards conformance
The OData Service is a non-updateable implementation of the OData Service v4 standard available

at http://www.odata.org/.

The OData Service meets theMUST requirements of the OData Minimal Conformance Level and

the vast majority of theMUST requirements of the OData Intermediate Conformance Level.

6.2 Calling the OData REST API
To learn about the OData Version 4.0 specification, please see the following links:

Part 1: Protocol
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part1-protocol.html

Part 2: URL Conventions
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part2-url-conventions.html

6.2.1 Query examples

Note: The following queries are provided as examples only. For details on constructing

URL query strings, please see the section 5 of theOData Version 4.0. Part 2: URL

Conventions document (http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part2-url-

conventions.html).

http://www.odata.org/
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part1-protocol.html
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part2-url-conventions.html
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part2-url-conventions.html
http://docs.oasis-open.org/odata/odata/v4.0/odata-v4.0-part2-url-conventions.html
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Required information Query

The feed metadata for all feeds available
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/$metadata

The query will return an XML document describing the available
entities.

The information on all blasts
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/Blasts

The query will return a JSON response describing every blast.
All properties of the blast entity will be included.

The information on the active blasts
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/Blasts?
$filter=Status%20eq%20BlastLogic.CHARGE.BlastStatus
%27Active%27
The query uses the $filter operator to retrieve only the active blasts.

The information on the Id, Name,
and Status properties of the blasts
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/Blasts?
$select=Name,Id,Status

The query uses the $select operator to retrieve only specified
columns.
This is useful to improve performance and reduce network bandwidth
usage.

Sorting the blasts in the site named CHARGE
by name and retrieve the first 10 blasts

http://blastlogic/21/odata/CHARGE/Blasts?
$top=10&$orderby=Name

The number of blasts with more than 100
holes
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/Blasts/
$count?$filter=HoleCount%20gt%20100

The query will return a plain text response containing a single integer
value.

The information on the blasts in the site
named CHARGE that were fired
in 2017 year (UTC)

http://blastlogic/21/odata/CHARGE/Blasts?
$filter=FiredTime%20ge%202017-01-01T00:00:00Z%20and%20
FiredTime%20lt%202018-01-01T00:00:00Z

The information on the blasts in the site
named CHARGE that were fired in 2017
year,
with time zone offset of 10 hours

http://blastlogic/21/odata/CHARGE/Blasts?
$filter=FiredTime%20ge%202017-01-01T00:00:00
%2B10:00%20and%20FiredTime%20lt%202018-01-01
T00:00:00%2B10:00

Note: The %2B is a URL-encoded + sign.

The information on the blasts with the multi-
select
custom property rock having the value SS
in the site named CHARGE

http://blastlogic/21/odata/CHARGE/Blasts?
$filter=rock%20has%20BlastLogic.CHARGE.rock%27SS%27

Tip: When developing complex query strings, it can be useful to query the OData service

using a full featured query UI such as Excel Power Query and then view the HTTP traffic using

Telerik Fiddler or equivalent.
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6.2.2 Authentication
The OData Service authentication principles are as follows:

BlastLogic Server instances deployed on-premise require clients to authenticate using

Windows Authentication (HTTP Negotiate / NTLM), either Integrated Windows Authentication

(IWA) or explicit user name and password.

Cloud-hosted BlastLogic Server instances require clients to authenticate using HTTP(S) basic

authentication using their Azure Active Directory credentials.

All site-based feeds and metadata requests require authentication.

6.2.3 Authorisation
Any user accessing the BlastLogic OData Service must meet the following conditions:

Be authorised as a BlastLogic user.

Be flagged as Active.
Be a member of a role assigned with the View blasts and View inventory permissions.

Note: Use the System Administration Tool panel in the BlastLogic Desktop application
(Home tab > Setup group > System Administration Tool > Roles and users tab) to add

roles, users, and assign users to the roles.
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Example
The image below shows a user namedMAPTEK-AU\BlastLogicService that is a member of
the Integration role for all sites. The Integration role includes the View blasts permission, thus
the user is authorised to execute all OData queries that require only view permissions.

Figure 6-1 Assigning a role to a user in the System Administration Tool panel of the BlastLogic Desktop
application

6.2.4 HTTP Accept headers
When requesting $metadata, you should specify one of the following:

Accept: application/json

Or

Accept: application/json

When requesting query results, you should specify Accept: application/json or omit the

Accept header entirely (XML query results are not supported in OData Version 4.0).

6.2.5 Server-driven pagination
When the number of results exceeds the maximum page size, the OData query results are returned

in pages. Each feed may have a different page size that is subject to change. Therefore, we

recommend avoiding making assumptions about page sizes.
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Query result JSON objects include a top-level property@odata.nextLink to enable clients to follow

a chain of result pages. The@odata.count property indicates the total number of query results.

You should request the@odata.nextLink URL on each subsequent page until it is null or absent.

Example
{

"@odata.context": "http://blastlogic/21/odata/CHARGE/$metadata#Holes",

"@odata.count": 11077,

"@odata.nextLink":

"http://blastlogic/21/odata/CHARGE/Holes?%24skiptoken=173%3a2",

"value": [ … ]

}
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6.3 Prototyping tips
OData queries can require the construction of complex URL query strings. Therefore, you may

benefit from prototyping in the following applications:

Microsoft Excel Power Query / Power BI Desktop

Telerik Fiddler

Postman

Microsoft Edge

Note: Google Chrome is currently not suitable for prototyping due to an incompatibility

issue with the Accept header.

When prototyping against an on-premise BlastLogic Server, the prototyping client needs to

authenticate using Windows Authentication as follows:

Power Query / Power BI Desktop Select Windows authentication

Telerik Fiddler Rules tab > click Automatically Authenticate to
enable authentication.

Postman Postman does not support Windows Authentication.
Proxy the requests through Fiddler and enable
Automatically Authenticate.

Microsoft Edge Should authenticate automatically out of the box.
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6.4 Time zone offsets
The OData service uses DateTimeOffset values to express an instant in time. The date and time

values returned from the OData service are supplied using the time zone offset that you can

configure in the BlastLogic Desktop client (Hometab > Setup group > Site > Locale > Time

zone), not the time zone that you have configured in Windows.

Figure 6-2 The time zone setting in the Site Setup panel in the BlastLogic Desktop
application

The date and time literals supplied as query parameters can be specified in UTC or with an offset.

Example:

The following values both represent 11 AM on the 1st January 2025 in Queensland, Australia:

2025-01-01T01:00:00Z

2025-01-01T11:00:00+10:00
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6.5 Optimising query performance
OData queries are able to return large data sets which can consume significant network and

computing resources. Developers and end users should aim to issue targeted queries designed to

return only the entities and properties required, rather than retrieving entire datasets and then

filtering the client side.

You should optimise query performance by doing the following:

Filter only the required entities.

Example

Rather than retrieving all holes, query the holes for a specified blast.

Rather than retrieving all blasts, query only the active blasts.

Rather than retrieving all loaded decks, query only the decks for a specified date

range.

Rather than retrieving all drilling events, query only the events for a specified date

range and drill machine name.

Select only the required properties.

Example

When identifying all active blasts, select only the Id and Name properties.

When retrieving dipping entries, if the site does not enter supervisor dip

measurements, do not select the SupervisorName, SupervisorDipDepth, and

SupervisorDipRequired properties.

Note: The HTTP Accept-Encoding header should specify gzip or deflate to minimise

network bandwidth consumption.

6.6 Custom properties
The Holes, Blasts, Drilling Entries, and Drilling Events feeds include custom properties. The schema

for the custom properties can be modified using the BlastLogic Desktop client any time by users

with sufficient authorisation.
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If you are a developer or a system integrator, you should take the following into consideration when

developing queries and integration packages:

Ideally, queries and packages should be implemented in a flexible and error-tolerant

way such that schema changes do not cause failures.

Schema changes could result in new properties, deleted properties, and properties changing

type.

For BlastLogic Server instances hosting multiple sites, it is entirely possible (and

likely) that each site will have different custom properties defined.

It should not be assumed that all sites have the same schema.
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7. Backwards Compatibility
BlastLogic is continually changing to meet the changing needs of the mining industry. As BlastLogic

changes, the structure of its data changes. These changes are reflected in BlastLogic OData

service.

Maptek endeavours to make all changes backwards-compatible with previous versions, however,

this is not always possible.

To help mitigate the effects of backward-incompatible changes, Maptek recommends any

consumer of OData should meet the following best practices:

Identify fields by column name instead of index.

Column names are fixed, column indexes can change.

Avoid retrieving unnecessary columns in an OData query.

Retrieving only the necessary columns reduces the chance that OData consumers will be

affected by changes to the OData feeds.

Keep the root URI for OData feeds in a single central location.

If a URI changes due, potentially due to a server changing names this can break OData

consumers.

Maintain clear documentation of the data lineage of all OData consumers.

Knowing what is there makes it easier to determine what is affected by changes.

Review the OData change history before BlastLogic is upgraded and identify what will

be affected.

Resolving issues before upgrading BlastLogic is much easier than resolving them after.
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8. Change History
See the table below for information on the changes that were made to the BlastLogic OData

Service.

Version Changes

2025.2 Added the following feeds:

TargetChargePlanDecks live and synchronisation feed
TargetChargePlanPrimers live and synchronisation feed

2023 Odata feeds have been rerouted to use data warehouse data. Live and sync feeds now report the same
data.

Data warehouse is updated when data changes, rather than during scheduled updates.

There is no row limit on querying live feeds.

2022 Added the following feeds:

HoleSnapshot feed
HoleSnapshotDeck feed
HoleSnapshotPrimer feed

2021.1 Added DensityMeasurements OData and sync feeds.

Added the SupervisorDipDepth field to the following feeds:

DrillingEntries feed
DrillingEntriesStable feed
DrillingEntries synchronisation feed
DrillingEntriesStable synchronisation feed

Added the DrillingShiftTotals synchronisation feed.
Changed the type of the following fields from single to double in SiteParametersOData and
synchronisation feeds:

CollarZToleranceLowerBound
CollarZToleranceUpperBound
CollarErrorTolerance
DrillDepthErrorToleranceLowerBound
DrillDepthErrorToleranceUpperBound
DipDepthTolerance
ChargeDepthToleranceLowerBound
ChargeDepthToleranceUpperBound

2021 Added the following feeds:

DrillingEvents feed
DrilingEventsStable feed

Added the following synchronisation feeds:

DrillingEvents synchronisation feed
DrilingEventsStable synchronisation feed

Changed the LoadedPrimers feed and LoadedPrimers synchronisation feed such that ProductIds and
ProductNames fields will display repeated product IDs and product names instead of only distinct values.
Added Shift field to the DrillingEntries, DrillingEntriesStable, DrillingEntries synchronisation, and
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Version Changes

DrillingEntriesStable synchronisation feeds.

2020.2 Changed the BlastProducts feed such that blast products that do not have an explicit cost will default to
the cost of the blast product family.

Added the following sync feeds:

InventoryChanges synchronisation feed
BlastProducts synchronisation feed
SiteParameters synchronisation feed

All properties in an entity are updated or inserted instead of only high value properties.

2020.1 Added the ChargeStandoff and ChargeStandoffDirection fields to the following feeds:

Holes feed
HolesStable feed

Made custom fields high value properties in the following OData synchronisation feeds:

Blasts
Holes
DrillingEntries

2020 Added the Cost field to the following feeds:

BlastProducts feed
ChargingEntryDecks feed
ChargingEntryPrimers feed
LoadedDecks feed
LoadedPrimers feed
ReconciledDecks feed
ReconciledPrimers feed

Holes feed: Added the DesignDrillCost field.
DrillingEntry feed: Added the PlanDrillCost and ActualDrillCost fields.
Added the following fields for the SiteParameters feed:

CostParametersDefaultBulkExplosiveCostPerKg
CostParametersDefaultDrillingCostPerMetre
CostParametersDefaultPrimerCostPerDeck
CostParametersFixedChargingCostPerHole
CostParametersFixedDrillingCostPerHole

Applied the following changes for the InventoryChanges feed:

Added theMagazineName andMagazineId fields.
Changed the Activity type Consumed to be Checked in or Checked out depending on the
amount.
Changed the type of ProductStockLevel and ProductChange fields from int to double.
The ProductStockLevel field contains the stock level per product and magazine, instead of stock
level sitewide.

3.0.2 Increased the limit on the number of rows returned by a query from 10,000 to 100,000.

3.0.1 BlastStatistics feed will appear in both the synchronisation feeds and the live feeds.

3.0 Added synchronisation OData feeds.

Moved BlastStatistics feed into the synchronisation feeds.

Limit the number of rows that can be returned by a query to 10,000.
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